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RX64M Group  
TCP/IP Protocol Stack Based Network Solution for Industrial Applications  
RX Driver Package Application 

Introduction  
This application note describes a network solution for industrial applications that uses the M3S-T4-Tiny TCP/IP 
protocol stack. This application note includes sample code for a main program that performs web server and module 
initialization and drive processing and, when used in combination with the RX64M Group RX Driver Package, allows 
the construction of web server systems. A sample application that operates combined with the RX Driver Package is 
referred to as an RX Driver Package Application. 

A web server is an application program that operates using TCP/IP. In general, a web server is accessed from web 
browsers and provides functions for using TCP/IP to transmit content stored on the web server to those browsers. 

This application note describes the procedure for main program and web server evaluation by combining the USB 
driver (host mass storage), FAT file system (M3S-TFAT-Tiny), Ethernet driver, and TCP/IP protocol stack (M3S-T4-
Tiny) included in the RX64M Group RX Driver Package. 

Target Device  
RX64M Group (Renesas Starter Kit+ RX64M) 

 
When using this application note with other Renesas MCUs, careful evaluation is recommended after making 
modifications to comply with the alternate MCU. 
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1. Overview 

1.1 This Application Note 
This application note describes a network solution for industrial applications that uses the M3S-T4-Tiny TCP/IP 
protocol stack. This application note includes sample code for a main program that performs web server and module 
initialization and drive processing and, when used in combination with the RX64M Group RX Driver Package, allows 
the construction of web server systems. A sample application that operates combined with the RX Driver Package is 
referred to as an RX Driver Package Application. 

A web server is an application program that operates using TCP/IP. In general, a web server is accessed from web 
browsers and provides functions for using TCP/IP to transmit content stored on the web server to those browsers. 

This application note describes the procedure for main program and web server evaluation by combining the USB 
driver (host mass storage), FAT file system (M3S-TFAT-Tiny), Ethernet driver, and TCP/IP protocol stack (M3S-T4-
Tiny) included in the RX64M Group RX Driver Package. 

This application note operates on the Renesas Starter Kit+ for RX64M (referred to as “RSK” in the remainder of this 
document). 
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1.2 Operating Environment 
This application note operates in the following environment. 

 
Table 1.2.1   Operating Environment 

Microcontroller RX64M Group 
Evaluation board Renesas Starter Kit+ RX64M 

http://japan.renesas.com/products/tools/introductory_tools/renesas_starter_kits/
rsk_plus_rx64m/index.jsp 

Integrated development 
environment (IDE) 

e2 studio, V3.0.1.09 or later 
Or: 
CubeSuite+ V2.02.00 or later 

Cross tools RX Family C/C++ Compiler Package V2.02.00 or later 
Emulator E1 (included in the Renesas Starter Kit+ for RX64M), E20 
RX Driver Package RX64M Group RX Driver Package Ver1.00 (R01AN2144EJ0100)* 
Note: * Operation of this application note has been verified when the modules in the RX Driver Package 

mentioned above are incorporated. If any of the modules used in this application note are replaced 
with a different module, the user must verify the operation. 

 

Development PC

USB memory

Switching hub

LAN cable
(straight)

AC 
adapter

Client PC 
(web browser)

IP: 192.168.0.100

 

Figure 1.2.1   Sample Operating Environment 

http://japan.renesas.com/products/tools/introductory_tools/renesas_starter_kits/rsk_plus_rx64m/index.jsp
http://japan.renesas.com/products/tools/introductory_tools/renesas_starter_kits/rsk_plus_rx64m/index.jsp


RX64M Group TCP/IP Protocol Stack Based Network Solution for Industrial Applications 
 RX Driver Package Application 

R01AN2153EJ0100  Rev.1.00  Page 4 of 66 
Sep 1, 2014  

1.3 Module Structure 
This section shows the structure of the modules used by this application note and a list of those modules. 

 

Figure 1.3.1   Module Structure 

 
Table 1.3.1   Modules 

Type Module  FIT Module Name Version 
Board Support Package Board support package (BSP module) r_bsp 2.60 
Device Driver Compare match timer (CMT) r_cmt_rx 2.30 
Device Driver Ethernet controller (ETHERC) r_ether_rx 1.00 
Middleware  M3S-T4-Tiny interface conversion module r_t4_driver_rx64m 1.00 
Middleware TCP/IP protocol stack (M3S-T4-Tiny) r_t4_rx 2.00 
Middleware FAT file system (M3S-TFAT-Tiny) r_tfat_rx 3.00 
Device Driver USB basic firmware r_usb_basic 1.00 
Device Driver USB host mass storage class r_usb_hmsc 1.00 
Application HTTP server r_t4_http_server_rx 1.03 
Application Web server system main program r_httpd_main_rx64m 1.00 
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1.4 File Structure 
This section describes the file structure used in this application note. 

 

Figure 1.4.1   File Structure 

 
When the ZIP file provided with this application note is decompressed, a folder with the same name is created and the 
various folders and files are created within that folder. 

The project is s special-purpose project for building a web server. It is used by inputting it to an e2 studio workspace. 
Also, Renesas provided project files, which are used to read the project with CubeSuite+, are also included. 

The Web server FIT modules are included in the FITModules folder. 

Documents that describe using the FIT modules in various development environments are included in the 
reference_documents folder. The document “Adding Firmware Integration Technology Modules to Projects” 
(r01an1723eu0110_rx.pdf) describes the method for including the FIT modules, as a FIT plugin, in an e2 studio project. 
The document “Adding Firmware Integration Technology Modules to CubeSuite+ Projects” (r01an1826ej0100_rx.pdf) 
describes the method for including the FIT modules in a CubeSuite+ project.  

The file “Application Note” (r01an2153ej0100_rx64m.pdf) is this document. 
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1.5 Projects 
This application note includes an e2 studio and a CubeSuite+ project for building and evaluating a web server system. 
These projects register both a build structure (build mode in CubeSuite+) that stores the build settings and a debug 
structure (debug tool in CubeSuite+) that stores debug settings. 

The table below lists the build structure and debug structure registered in these projects. 

 
Table 1.5.1   Project Settings 

 Structure Description 
Build structure  
(referred to as build mode 
in CubeSuite+) 

HardwareDebug  
(Debug on hardware) 

This structure is used to generate a load 
module with debugging information included. 
Main settings 
• Debug information present 
• No optimization (-optimize=0) 

Debug structure  
(referred to as debug tool 
in CubeSuite+) 

HardwareDebug (E1) 
(This is RX E1 (JTAG) in 
CubeSuite+) 

Used for hardware debugging over an E1 
emulator using a load module generated by 
HardwareDebug (Debug on hardware). 
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2. Acquiring a Development Environment 

2.1 Acquire and Install e2 studio 
The e2 studio can be downloaded from the Renesas web site. 

 
1.  Access the following URL to display the e2 studio download page. 

http://www.renesas.com/e2studio_download 
 
2.  Of the displayed items, click Install the e2 studio 3.0.0.22 installer. (Although there are two versions, one that is 

broken up into smaller sections, and one that can be downloaded in a single operation, the contents are the same.) 
Next, download the e2 studio installer by following the instructions displayed. 

  
 
3.  Run the downloaded e2 studio installer to install e2 studio on your personal computer. 

See the e2 studio Integrated Development Environment User's Manual: Getting Started Guide for details on 
the installation procedure. 
http://documentation.renesas.com/doc/products/tool/doc/r20ut2771ej0200_e2_start_s.pdf 

 

Click either of these 
links. 
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2.2 Acquire a Compiler Package 
The RX Family C/C++ Compiler Package, V2.02.00 or later, is required to build this web server system. This section 
assumes the user does not own the commercial version and will be using the free evaluation version. 

 
1.  Access the following URL to display the e2 studio download page. 

http://www.renesas.com/e2studio_download 
 
2.  Of the displayed items, click [Evaluation Software] RX Family C/C++ Compiler Package V2 (without IDE) 

V2.02.00. 
Follow the instructions on the page displayed next to download the compiler installer. 

  
 
3.  Run the downloaded compiler installer to install the compiler on your personal computer. 
 
 

Click this link. 
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2.3 Upgrade to Version 3.0.1.09 
Upgrade the e2 studio that is installed on your personal computer to the latest version. 

 
1.  Access the following URL to display the e2 studio download page. 

http://www.renesas.com/e2studio_download 
 
2.  Click the version information link on the right side of the displayed page. 

  
 
3.  Of the displayed items, click the link shown as e2 studio, Eclipse open-source based Integrated Development 

Environment, revised to V3.0.1.09. 
Follow the directions on the displayed page to perform the e2 studio update. 

  
 
 

Click this link. 

Click this link. 
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3. Environment Preparation 

3.1 Install the FIT Modules 
Install the FIT modules used in the web server system in this application note into e2 studio. 

 
1.  Decompress the ZIP file in which this application note is provided into an arbitrary folder. 
 
2.  Open the folder into which that ZIP file was decompressed and of the folders in that folder, open the FITModules 

folder. 
 
3.  Select all of the files in the FITModules folder and click Copy in the Edit menu. 

 
 
4.  Open the e2 studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in 

that folder. 
 
5.  Click Paste on the Edit menu. 

The e2 studio FITModules folder will be copied to the FIT modules. 

 

Select all files and click 
Copy in the Edit 
menu. 

Open the FITModules 
folder and click Paste  
on the Edit menu.  
The folder will be copied. 
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3.2 Install the RX Driver Package 
Install the FIT modules included in the RX64M Group RX Driver package in e2 studio. 

 
1.  Download the RX64M Group RX Driver package and decompress the file an_r01an2144ej0100_rx64m.zip into an 

arbitrary folder. 
 
2.  Open the folder that was decompressed and open the FITModules folder in that folder. 
 
3.  Select all the files in the FITModules folder, and click Paste on the Edit menu. 

 
 
4.  Open the e2 studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in 

that folder. 
 
5.  Click Paste on the Edit menu. 

The e2 studio FITModules folder will be copied to the FIT modules. 

 
 

Select all files and click 
Copy in the Edit menu. 

Open the FITModules 
folder and click Paste  
on the Edit menu.  
The folder will be copied. 
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4. Building a Project 

4.1 Create a Workspace 
 
1.  Start e2 studio. 
 
2.  Enter an arbitrary workspace folder in the displayed dialog box and click OK. 

 
 
3.  When the following window is displayed, click Workbench. 

 
 

Enter a workspace 
folder. 

Click OK. 

Click Workbench. 



RX64M Group TCP/IP Protocol Stack Based Network Solution for Industrial Applications 
 RX Driver Package Application 

R01AN2153EJ0100  Rev.1.00  Page 13 of 66 
Sep 1, 2014  

4.2 Import a Project 
Import the project provided with this application note into the newly created workspace. 

 
1.  Select Import from the e2 studio File menu. 

 
 
2.  Select Existing Projects into Workspace from General and click Next. 

 
 

Click here. 

Select Existing Projects 
into Workspace from 
General and click Next. 
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3.  Click Browse. 

 
 
4.  Select the project folder associated with this application note and click OK. 

 
 

Click here. 

Select this 
project folder 
and click OK. 



RX64M Group TCP/IP Protocol Stack Based Network Solution for Industrial Applications 
 RX Driver Package Application 

R01AN2153EJ0100  Rev.1.00  Page 15 of 66 
Sep 1, 2014  

5.  Check Copy projects into workspace and click Finish. 

 
 

Check this box 
and click Finish. 
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4.3 Add the Web Server System FIT Modules to the Project 
Use the e2 studio FIT plugin to add the FIT modules used by the web server system to the project. 

 
1.  Select Renesas FIT Module from New in the e2 studio File menu to start the FIT plugin. 

 
 
2.  Set the FIT plugin items as shown below. 

 
 

Click here. 

Set this item. 
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3.  Select r_httpd_main_rx64m from the FIT plugin module list and click Finish. 

 
 
4.  A variety of message dialog boxes will be displayed. Click OK in all of them. 

The above procedure will have installed all the required FIT modules into the project. The project structure after this 
installation is shown below. 

 

 

Select this item 
and click Finish. 
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4.4 Set Up Board Support Package (BSP Module) 
4.4.1 Copy Configuration File 
Copy the configuration file for the microcontroller used to the r_config folder. 

 
1.  From the e2 studio project explorer, open r_bsp/board/rskrx64m and select two files: r_bsp_config_reference.h 

and r_bsp_interrupt_config_reference.h. Then click Copy on the Edit menu. 

  
 
2  Select the r_config folder and click Paste on the Edit menu. 

  
 

Select the two files 
and then click Copy 
on the Edit menu. 

Select the r_config 
folder and click 
Paste on the Edit 
menu. 
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3. Rename the copied files to r_bsp_config.h and r_bsp_interrupt_config.h, that is, remove _reference from the file 
names. 

  
 
 

4.4.2 Edit platform.h 
Modify platform.h to correspond to the target board being used. 

Open r_bsp/platform.h and remove the comment from the include line for the RSKRX64M r_bsp.h file. 

r_bsp/platform.h 

/* RDKRX63N */ 
//#include "./board/rdkrx63n/r_bsp.h" 
 
/* RDKRX631 */ 
//#include "./board/rdkrx631/r_bsp.h" 
 
/* RSKRX64M */ 
#include "./board/rskrx64m/r_bsp.h" 
 
/* RSKRX210 */ 
//#include "./board/rskrx210/r_bsp.h" 
 
/* HSBRX21AP */ 
//#include "./board/hsbrx21ap/r_bsp.h" 

 

Rename these files. 
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4.5 Modify Configuration 
The configuration files for each of the FIT modules that make up the web server system must be modified. 

Refer to the manuals and other files in the doc folder for each FIT module for details on the items and their settings in 
the configuration files. 

The places that must be changed in the configuration files to operate this web server system are shown below. 

 

4.5.1 Change Interrupt Stack Size 
In this web server system, the main web server processing is performed from the Ethernet controller's interrupt handler. 
This requires about 2.5 KB of interrupt stack. 

Modify the interrupt stack size defined in the r_bsp configuration file as shown below. 

r_config/r_bsp_config.h 

/* Interrupt Stack size in bytes. The Renesas RX toolchain sets the stack 
size using the #pragma stacksize directive. 
 * If the interrupt stack is the only stack being used then the user will 
likely want to increase the default size 
 * below. 
 */ 
#pragma stacksize si=0x1000 

 

4.5.2 Change Compare Match Timer Driver Settings 
Set interrupt priority of compare match timer lower than interrupt priority of the USB driver (IPR=3). 

r_config/r_cmt_rx_config.h 

/* The interrupt priority level to be used for CMT interrupts. */ 
#define CMT_RX_CFG_IPR         (2) 

 

4.5.3 Change USB Driver Settings 
Set channel 0 to be unused (USB_NOUSE_PP). 

r_config/r_usb_config.h 

//  #define USB_FUNCSEL_USBIP0_PP  USB_HOST_PP     /* Host Mode */ 
//  #define USB_FUNCSEL_USBIP0_PP  USB_PERI_PP     /* Peripheral Mode */ 
    #define USB_FUNCSEL_USBIP0_PP  USB_NOUSE_PP 
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4.5.4 Change T4 Settings 
Change the T4 settings as shown below. 

Comment out the t4_callback function external reference declaration and add a new external reference declaration for 
the http_callback function. 

r_t4_rx/src/config_tcpudp.c 

#include "r_t4_itcpip.h" 
//extern ER t4_callback(ID cepid, FN fncd , VP p_parblk); 
extern ER http_callback(ID cepid, FN fncd , VP p_parblk); 

 
Increase the number of TCP reception points to 6 and modify each local point. 

r_t4_rx/src/config_tcpudp.c 

/*** Definition of TCP reception point (only port number needs to be set) ***/ 
T_TCP_CREP tcp_crep[6] = 
{ 
    /* { attribute of reception point, {local IP address, local port number}} */ 
    { 0x0000, { 0, 80 }}, 
    { 0x0000, { 0, 80 }}, 
    { 0x0000, { 0, 80 }}, 
    { 0x0000, { 0, 80 }}, 
    { 0x0000, { 0, 80 }}, 
    { 0x0000, { 0, 80 }}, 
}; 

 
Change the TCP communication end point setting as shown below. 

r_t4_rx/src/config_tcpudp.c 

/***  Definition of TCP communication end point 
      (only receive window size needs to be set) ***/ 
T_TCP_CCEP tcp_ccep[6] = 
{ 
    /* { attribute of TCP communication end point, 
         top address of transmit window buffer, size of transmit window  
         buffer,top address of receive window buffer, size of receive window  
         buffer, address of callback routine } 
    */ 
    { 0, 0, 0, 0, 1460, http_callback }, 
    { 0, 0, 0, 0, 1460, http_callback }, 
    { 0, 0, 0, 0, 1460, http_callback }, 
    { 1, 0, 0, 0, 1460, http_callback }, 
    { 1, 0, 0, 0, 1460, http_callback }, 
    { 1, 0, 0, 0, 1460, http_callback }, 
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Change in 10 ms to the 2MSL Wait Time. 

 
 

4.5.5 Change HTTP Server Settings 
Change the CGI_FILE_NAME_TABLE_LIST as shown below. 

r_config/r_t4_http_server_rx_config.h 

/*#define CGI_FILE_NAME_TABLE_LIST \*/ 
/*  {"cgi_smpl.cgi", NULL}, \*/ 
extern ER cgi_sample_function(ID cepid, void *res_info); 
#define CGI_FILE_NAME_TABLE_LIST \ 
    {"cgi_smpl.cgi", cgi_sample_function, NULL}, \ 

 
 

Change in 6 to maximum number of clients that can be accepted at the same time to match tcp_ccep table of 
r_t4_rx/src/config_tcpudp.c. 

r_config/r_t4_http_server_rx_config.h 

// set same value number of CEPID in config_tcpudp.c 
#define HTTP_TCP_CEP_NUM 6 

 

 

/***  2MSL wait time (unit:10ms)  ***/ 
const UH    _tcp_2msl[] =  
{ 
    (1),      /* 10 ms */ 
    (1),      /* 10 ms */ 
}; 

【r_t4_rx/src/config_tcpudp.c】 
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4.6 Modify Source Code 
The places that must be changed in the source code to operate this web server system are shown below. 

 

4.6.1 Allows multiple interrupts 
This system uses multiple interrupts.  

Allow interrupts before calling the _process_tcpip function called in the lan_inthdr handler function and the 
timer_interrupt handler function in the t4_driver.c. 

r_t4_driver_rx64m/src/t4_driver.c 

/****************************************************************************** 
Functions (Interrput handler) 
******************************************************************************/ 
 
void timer_interrupt(void *pdata) 
{ 
 R_BSP_InterruptsEnable(); 
 
 if (tcpip_flag == 1) 
 { 
  _process_tcpip(); 
  tcpudp_time_cnt++; 
 } 
 
 /* for wait function */ 
 if (wait_timer < 0xFFFF) 
 { 
  wait_timer++; 
 } 
} 
 
void lan_inthdr(void *ppram) // callback from r_ether.c 
{ 
 R_BSP_InterruptsEnable(); 
 
 if (tcpip_flag == 1) 
 { 
  _process_tcpip(); 
 } 
} 
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5. Verify Operation 

5.1 Build the Project 
Use the following procedure to build the project and generate a load module. 

 
1.  Click the project to build from the Project Explorer. 

 
 
2.  Click Build project from the Project menu. 

 
 
3.  When “Build complete” is displayed on the Console panel, the build will have completed. 

 
 

Click here. 

Click here. 
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5.2 Prepare for Debugging 
5.2.1 Configure Hardware 
The evaluation board must be configured before starting debugging. 

A table of the required equipment and its configuration are shown below. 

 
Table 5.2.1.1   Hardware Configuration 

No. Device Supplementary Information 
1 Development PC Personal computer used for development 
2 Evaluation board  

(Renesas Starter Kit+ for RX64M) 
 

3 USB memory Memory that is formatted as either FAT or FAT32. 
4 Client PC (web browser) The development PC can be used for this function. 
5 One of the following must be provided as a 

network environment for connecting the client 
PC to the RSK (web server). 
1.  If a switching hub is used 

a. Switching hub 
b. LAN cable (straight) × 3 

2.  If cross cables are used 
a. LAN cable (cross) × 2 

If cross cables and two Ethernet channels are 
used, then the client PC must have two LAN ports. 
When only one Ethernet channel is used, the 
number of LAN cables required will be as follows. 
1.  If a switching hub is used 

LAN cable (straight) × 2 
2.  If cross cables are used 

LAN cable (cross) × 1 
 

Development PC

USB memory

Switching hub Client PC 
(web browser)

IP: 192.168.0.100

LAN cable
(straight)

AC 
adapter

Switching Hub Configuration (two Ethernet channels used)

 

Figure 5.2.1.1   Switching Hub Configuration (Two Ethernet Channels Used) 
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USB memory

LAN cable
(cross)

AC 
adapter

Cross Cable Configuration (two Ethernet channels used)

Development PC

Client PC 
(web browser)

IP: 192.168.0.100

 

Figure 5.2.1.2   Cross Cable Configuration (Two Ethernet Channels Used) 
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5.2.2 Set Up the Evaluation Board 
The evaluation board settings required to operate the web server system are shown below. 

 

1.  Set the USB ch0 mode (host/peripheral). Set jumpers J2 and J6 to match the setting of 
USB_FUNCSEL_USBIP0_PP in r_usb_config.h. 

2.  Set the USB ch1 mode (host/peripheral). Set jumpers J7 and J9 to match the setting of 
USB_FUNCSEL_USBIP1_PP in r_usb_config.h. 

3.  Specify the PHY IC channel used to control the PHY IC from the Ethernet controller. Set jumpers J3 and J4 to 
match the settings of ETHER_CFG_CH0_PHY_ACCESS and ETHER_CFG_CH1_PHY_ACCESS in 
r_ether_rx_config.h. 

 
Table 5.2.2.1   Jumper Settings 

No. Setting Jumper Setting 
1 When use USB0 in host mode. J2 Short 1 to 2. 
 (USB_FUNCSEL_USBIP0_PP = USB_HOST_PP) J6 Short 2 to 3. 

When use USB0 in peripheral mode. J2 Short 2 to 3. 
 (USB_FUNCSEL_USBIP0_PP = USB_PERI_PP) J6 Short 1 to 2. 
2 When use USB1 in host mode. J7 Short 1 to 2. 

(USB_FUNCSEL_USBIP1_PP = USB_HOST_PP) J9 Short 2 to 3. 
When use USB1 in peripheral mode. J7 Short 2 to 3. 

 (USB_FUNCSEL_USBIP1_PP = USB_PERI_PP) J9 Short 1 to 2. 
3 Control the PHY IC with ch1. J3 Short 2 to 3. 
  J4 Short 2 to 3. 
 

Jumper J6
Jumper J2

Jumper J9
Jumper J7

Jumper J4
Jumper J3

 
Note: The image and the actual settings differ. 

Figure 5.2.2.1   Renesas Starter Kit+ for RX64M Jumper Locations 
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5.2.3 Set Up Client PC 
Set up the network on the client PC. This section shows the procedure when using Windows 7 as an example. 

 
1.  Open the Control Panel on the client PC and click Network and Internet. 

 
 
2.  Click Network and Sharing Center. 

 
 

Click here. 

Click here. 
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3.  Click Change adapter settings. 

 
 
4.  Right click Local Area Connection and select Properties. 

 
 

Click here. 

Click here. 
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5.  Select Internet Protocol Version 4 (TCP/IPv4) and click Properties. 

 
 
6.  The IP address and other settings will be displayed. Set these as shown below and click OK. 

 
 

Click here. 

Click here. 
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5.2.4 Prepare USB Memory 
Store the HTML content on the USB memory. 

 
1.  Open the src folder in the project and then open the contents folder in that folder. Open the contents.zip file in the 

contents folder. Copy the contents folder in the demo folder to the USB memory. 

 

 
 

Copy the contents 
folder. 
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5.3 Debug the Project 
Use the following procedure to start debugging the project. 

 
1.  Connect the development PC to the E1 emulator with a USB cable. 
2.  Connect the evaluation board (Renesas Starter Kit+ for RX64M) to the adapter and turn on the power. 
3.  Click Debug Configurations in the e2 studio Run menu. 

 
 
4.  Click r_httpd_system_rx64m HardwareDebug under Renesas GDB Hardware Debugging and click Debug. 

  
 

Click here. 

Click here. 
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When the following message is displayed, click Yes. 

  
 

When the load module download completes, a Debug perspective opens. 

 
 
5.  Click Resume on the toolbar. The program will be executed and a break will occur at the start of the main function. 

  
 

After the break at the start of the main function, click Resume on the tool bar again. 
 

Click here. 

Click here. 
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6.  Start a web browser on the client PC and enter the following address according to which port the LAN cable is 
connected. 
Ethernet Port Number Web Server Address 
0 http://192.168.0.3 
1 http://192.168.0.10 
Note:  Note that the web address can be changed in the configuration. 

 
A list of files in the root directory on the USB memory will be displayed. The file name is listed in the Name field, 
the last date on which the file was changed is listed in the Last modified field, and for directories, (dir) is listed as in 
the size field while for files, the size is shown in bytes. Click Parent Directory to move to the next higher directory. 

 
 
7.  Click CONTENTS and then click the file DEMO.HTM. This will display a page like the one shown below. The 

LEDs on the board can be controlled (turned on or off) by pressing the LEDx button. 

  
 

Click here. 
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6. Web Server Specifications 

6.1 Performance Overview 
This is a simple web server that is implemented based on the HTTP/1.0 specifications. This web server is intended to 
serve as a base when a user develops their own web server to be embedded in an end product and that web server will 
run under M3S-T4-Tiny (referred to as T4 in the remainder of this document). This web server does not included any 
countermeasures for attacks such as SYN-FLOOD and does not include any security functions. Therefore it is not 
appropriate for applications in which it is operated as a server connected to the internet waiting on a www port (number 
80). This sample program as developed assuming it would be used only in local networks in which malicious actors are 
not present, such as a network within a business office or factory. Also, the file names it can handle are limited to short 
file names only. 

Note that except for file I/O, this web server operates on microcontroller internal memory only and does not require any 
special memory. While its processing performance is affected by RAM capacity, this parameter is defined in the 
program so that it can be set flexibly. In this web server the memory usage is set appropriately for the ROM/RAM 
capacity of the RX64M microcontroller. 

The table below lists the performance of this web server. 

 

Table 6.1.1   Web Server Performance 

Item Performance 
ROM size About 6.6 KB 
RAM size About 36 KB 

(About 5 KB × number of simultaneous connected clients + α) 
Number of simultaneous 
connections 

5 clients (this parameter can be set) 

CGI functions Functions that can remotely control the microcontroller from the web browser. 
 
 

6.2 Operation Overview 
Compared to the web servers (such as Apache) that are widely used on the internet, this web server holds the set of 
functions implemented to an absolute minimum. Furthermore, it is implemented with nonblocking calls to make it easy 
to use in embedded application, and the application can perform web server processing simply by calling R_httpd() 
periodically. The function R_httpd() monitors all communication endpoints (normally called sockets) and transitions to 
the connection wait state if a socket goes to the disconnected state. Communication processing is performed in the T4 
API function _process_tcpip(), and in this web server, this API function is called from timer interrupts and Ethernet 
interrupts. To report the completion of processing the _process_tcpip() function calls a callback function. HTTP data 
analysis processing and data generation processing is performed in this callback function.  

The processing time required by these interrupt processing operations, including activation of the _process_tcpip() 
function can vary greatly depending on the performance of the transmit/receive drivers and the implementation of the 
callback routine. Accordingly, if necessary, operation of the application can be given priority by reducing the priority of 
these interrupts or by disabling interrupts entirely. 

Furthermore, the behavior of this web server can be customized by modifying macro definitions in the configuration file, 
r_t4_http_server_rx_config.h. 

 

6.3 CGI Functions 
This web server provide simplified CGI (Common Gateway Interface) functions. CGI is a mechanism for calling user 
function in a web browser according to requests from that web browser. In this web browser, when a URL set in 
advance as a CGI file is requested, the corresponding internal function is called. 
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6.4 Configuration 
The web server's behavior can be customized by modifying the macro definitions in the configuration file 
(r_t4_http_server_rx_config.h). 

 

• Server header field: HTTPD_VERSION_CODE 
The data stored in the server header field transmitted to the web browser when communicating with the web 
browser can be specified. 

 
• Root directory: ROOT_DIR  

Which directory in the external memory is taken to be the root directory can be specified. 
Examples: #define ROOT_DIR “”  
 #define ROOT_DIR “user”  
 #define ROOT_DIR “user/root_dir” 

 
• Display or don’t display index page: INDEXES 

The behavior when a directory is specified by the web browser can be specified. 
When 1 is specified, the response is the directory contents. 
When 0 is specified, the response is the file specified by DEFAULT_FILE_NAME. 

 
• Response file when index page not displayed: DEFAULT_FILE_NAME 

This is the file that is returned when INDEXES is 0. 
If this file cannot be found, the 404 Not Found response will be returned. 

 
• Number of corresponding content types: MAX_EXTENSION  

Specifies the number of definitions in the file extension list for files stored in external memory. 
 
• Corresponding content types: EXTENSION_TYPE_TABLE_LIST  

This is a list of file extensions for files stored in external memory. 
When a file with an extension that is not in this list is transmitted, the file is returned with the settings for the file 
extension defined at the start of this list. 

 
• Number of register CGI files: MAX_CGI_FILE 
 
• Table of correspondences between CGI file names and internal functions: CGI_FILE_NAME_TABLE_LIST 
 
• Newline code used for index page generation: LF_CODE  
 
• Maximum number of clients that can be accepted at the same time: TCP_CEP_NUM  

This must be set to match the number of endpoints defined in the T4 source file config_tcpudp.c. 
 
• Maximum number of files that can be displayed on the index page: MAX_FILE_LIST 

This must be set so that BODY_BUF_SIZE is not exceeded. 
 
• Receive buffer size: RCV_BUF_SIZE 
 
• Header field transmit buffer size: HDR_BUF_SIZE  
 
• Body field transmit buffer size: BODY_BUF_SIZE  
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6.5 Files 
The table below lists the files in this web server. 

 
Table 6.6.1   Web Server Files 

Folder Name File Name Description 
r_t4_http_server_rx/src r_http_server.c Web server source file 

r_http_server_config.c Web server configuration source file 
r_http_server_config.h Web server configuration header file 

 

6.6 API Reference 
6.6.1 R_httpd 

Description 
The application calls this function periodically. R_httpd() manages the sockets required for HTTP communication. 
This function only manages these sockets while the communication itself is performed automatically by T4 interrupt 
drive. 

Usage 
#include “r_t4_http_server_rx_if.h” 
void R_httpd (void); 

Parameters 
None 

Return Value 
None 

Remark 
None 
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6.6.2 R_httpd_pending_release_request 

Description 
Application calls this function when release the CGI pending 
Please refer to the section 6.9.1cgi_sample_function. 

Usage 
#include “r_t4_http_server_rx_if.h” 
void R_httpd_pending_release_request(ID cepid); 

Parameters 
cepid input  communication endpoint ID 

Return Value 
None 

Remark 
None 

 
 

6.6.3 R_T4_HTTP_SERVER_GetVersion 

Description 
Returns the version of this module. The version number is encoded such that the top two bytes are the major version 
number and the bottom two bytes are the minor version number. 
For example, version ‘4.25’, the return value is ‘0x00040019’. 

Usage 
#include “r_t4_http_server_rx_if.h” 
uint32_t R_T4_HTTP_SERVER_GetVersion(void); 

Parameters 
None 

Return Value 
Version number of Web server 

Remark 
None 
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6.7 User-Defined Function Reference (File I/O) 
This web server calls this set of functions. The user must define the processing performed by these function 
appropriately for the file system used. Also, this web server uses this data structure and can acquire information from 
external memory. This web server is defined using TFAT as a sample file system. 

 

Table 6.8.1   User-Defined Functions 

Function Name Function Overview Function Name Function Overview 
change_dir() Changes the working directory file_write() Writes to a file 
file_close() Closes a file get_file_info() Acquires file information 
file_delete() Deletes a file get_file_list_info() Acquires a file list 
file_open() Opens a file get_file_size() Acquires a file’s size 
file_read() Reads a file make_dir() Creates a directory 
file_rename() Renames a file remove_dir() Deletes a directory 
file_exist() Verifies that a file exists   
Note:  Of the above functions, the ones that this web server does not call are grayed out. 
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6.7.1 Data Structures 

Date Information Structure 
typedef struct date_info_ 

{ 

 uint16_t  year;   // 2011, 2012, … 

 uint8_t  month[4];  // Jan, Feb, Mar, … 

 uint8_t  day;   // 1-31 

 uint8_t  day_of_the_week[4]; // Sun, Mon, Tus, … 

 uint16_t  hour;    // 0-23 

 uint16_t  min;    // 0-59 

 uint16_t  sec;    // 0-59  

}DATE_INFO; 

File List Structure 
typedef struct file_list_ 

{ 

 uint8_t  file_name[13]; 

 uint32_t  file_size; 

 uint32_t  file_attr; 

 DATE_INFO date_info;  

}FILE_LIST; 

Macro Definitions 
#define FILE_WRITE  (0x10) 

#define FILE_READ  (0x01) 

#define FILE_ATTR_RDO 0x01 /* Read only */ 

#define FILE_ATTR_HID  0x02 /* Hidden */ 

#define FILE_ATTR_SYS 0x04 /* System */ 

#define FILE_ATTR_VOL 0x08 /* Volume label */ 

#define FILE_ATTR_DIR  0x10 /* Directory */ 

#define FILE_ATTR_ARC 0x20 /* Archive */ 
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6.7.2 change_dir 

Description 
This function sets the directory path specified with the argument to be the working directory. The directory path is 
specified as a full path name. The information in the working directory is managed by each socket. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t change_dir(uint8_t *dir_path); 

Parameters 
dir_path Input Storage location for the specified directory path 

Return Value 
-1  The directory does not exist 
0  The directory exists 

Remark 
There are cases where the directory path ends with a "/", and cases where it does not. The presence or absence of the 
final "/" must be determined according to the file system used. 

 



RX64M Group TCP/IP Protocol Stack Based Network Solution for Industrial Applications 
 RX Driver Package Application 

R01AN2153EJ0100  Rev.1.00  Page 42 of 66 
Sep 1, 2014  

6.7.3 file_close 

Description 
This function performs a close operation on the file with the ID value specified in the argument and discards the 
management information. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_close(int32_t file_id); 

Parameters 
file_id Input ID value for the file to be closed 

Return Value 
-1  Error 
0  Normal completion 

Remark 
None 

 

6.7.4 file_delete 

Description 
This function deletes the file with the ID value specified in the argument. The file is specified as a full path name 
starting with the root directory. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_delete(uint8_t *file_path); 

Parameters 
file_path Input Storage location that holds the full path name for the file. 

Return Value 
-1  Error 
0  Normal completion 

Remark 
None 
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6.7.5 file_open 

Description 
This function opens the file specified by the first argument in the mode specified by the second argument. 
Furthermore it returns as its return value the ID value for the stored management information so that the web server 
can reference it using that ID. This stored management information must be stored until that ID value is specified to 
the file close function. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_open(uint8_t *file_path, uint8_t mode_flag); 

Parameters 
file_path  Input Storage location that holds the full path name for the file. 
mode_flag   input File open mode (FILE_WRITE or FILE_READ) 

Return Value 
-1  Error 
0  ID value for the opened file 

Remark 
The file open state must be stored until that file’s ID value is specified to the file close function. 

 

6.7.6 file_read 

Description 
This function reads the amount of file data specified by the third argument from the file corresponding to the ID 
value specified by the first argument to the address specified by the second argument. The file pointer in the 
management information corresponding to the ID value of the first argument is updated by the amount of data read 
and saved until the file close function is called. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_read(int32_t file_id, uint8_t *buf, int32_t read_size); 

Parameters 
file_id Input ID value for the file to be read 
buf  Output Storage address for the file data to be read 
read_size Input Size of the file data to be read 

Return Value 
-1  Error 
0  Size of data read 

Remark 
None 
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6.7.7 file_rename 

Description 
This function changes the name of the file or directory specified by the first argument to the name specified by the 
second argument. Both the first and second arguments are full path names from the root directory. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_rename(uint8_t *old_name, uint8_t *new_name); 

Parameters 
old_name Input File or directory to be modified 
new_name Input Name after modification 

Return Value 
-1  Error 
0  Normal completion 

Remark 
None 

 

6.7.8 file_exist 

Description 
This function verifies whether or not the file or directory specified by the first argument exists. The argument is 
specified as a full path name from the root directory. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_exist(uint8_t *file_path); 

Parameters 
file_path Input File or directory whose existence is to be verified 

Return Value 
-1  Does not exist 
0  Does exist 

Remark 
None 
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6.7.9 file_write 

Description 
This function writes the amount of data specified by the third argument to the file with the ID value specified by the 
first argument to the address specified by the second argument. The file pointer in the management information 
corresponding to the ID value of the first argument is updated by the amount of data written and saved until the file 
close function is called. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t file_write(int32_t file_id, uint8_t *buf, int32_t write_size); 

Parameters 
file_id Input ID value for the file to be written 
buf  Input Start address of the data to be written 
write_size Input Size of data to be written 

Return Value 
-1  Error 
0  Normal completion 

Remark 
None 

 

6.7.10 get_file_info 

Description 
This function reads in the file management information for the file corresponding to the ID value specified by the 
first argument and writes the data information structure specified by the second argument to the files date 
information. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t get_file_info(int32_t file_id, DATE_INFO *date_info); 

Parameters 
file_id Input ID value for the file to be read 
date_info Output Storage address of the date information 

Return Value 
-1  Error 
0  Normal completion 

Remark 
None 
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6.7.11 get_file_list_info 

Description 
This function writes the information for either the file or directory stored at directory path specified by the first 
argument to the file list structure specified by the second argument. The maximum number of information items 
written out is specified by the third argument and file list read start position is specified by the fourth argument. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t get_file_list_info(uint8_t *dir_path, FILE_LIST *file_list, uint32_t num_file_list, int32_tread_index); 

Parameters 
dir_path Input Storage address for the directory path to read 
file_list Output Storage address for the read out file list 
  Note that '\0' will be stored at the start of the file name structure at the end of the list. 
num_file_list Input Maximum number of file list information items to read at one time 
read_index Input File list read out start position 

Return Value 
-1  Error 
0  Number of file items read out 

Remark 
When the return value is smaller than num_file_list, it indicates that file list information readout has completed and 
when it is the same as num_file_list, it indicates that there is still more information to read out. When reading out 
continued values from the file list, call this function with read_index specified to be the file list read start position. 
There are cases where dir_path ends with a "/", and cases where it does not. The presence or absence of the final "/" 
must be determined according to the file system used. 

 



RX64M Group TCP/IP Protocol Stack Based Network Solution for Industrial Applications 
 RX Driver Package Application 

R01AN2153EJ0100  Rev.1.00  Page 47 of 66 
Sep 1, 2014  

6.7.12 get_file_size 

Description 
This function reads the management information for the file corresponding to the ID value specified by the first 
argument and returns the file size. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t get_file_size(int32_t file_id); 

Parameters 
file_id Input ID value for the file to be read 

Return Value 
-1  Error 
0  File size 

Remark 
None 

 

6.7.13 make_dir 

Description 
This function creates the directory specified by the argument. This directory path is specified as a full path name. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t make_dir(uint8_t *dir_path); 

Parameters 
dir_path Input Directory name to be created 

Return Value 
-1  Error 
0  Normal completion 

Remark 
There are cases where dir_path ends with a "/", and cases where it does not. The presence or absence of the final "/" 
must be determined according to the file system used. 
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6.7.14 remove_dir 

Description 
This function deletes the directory specified by the argument. This directory path is specified as a full path name. 

Usage 
#include <stdint.h> 
#include “r_file_driver.h” 
int32_t remove_dir(uint8_t *dir_path); 

Parameters 
dir_path Input Directory to be deleted 

Return Value 
-1  Error 
0  Normal completion 

Remark 
There are cases where dir_path ends with a "/", and cases where it does not. The presence or absence of the final "/" 
must be determined according to the file system used. 

 
 



RX64M Group TCP/IP Protocol Stack Based Network Solution for Industrial Applications 
 RX Driver Package Application 

R01AN2153EJ0100  Rev.1.00  Page 49 of 66 
Sep 1, 2014  

6.8 User-Defined Function Reference (System Timer) 
This web server calls these functions. User defines system timer. 

 

Table 6.8.1   User-Defined Functions 

Function Name Function Overview 
get_sys_time() Get pointer to system time 

 
6.8.1 Data Structures 

System Time Structure 
typedef struct sys_time_ 

{ 

 uint32_t  sec; 

 uint32_t  min; 

 uint32_t  hour; 

 uint32_t  day; 

 uint32_t  month; 

 uint32_t  year; 

}SYS_TIME; 

 

6.8.2 get_sys_time 

Description 
This function gets pointer to system time. 

Usage 
#include <stdint.h> 
#include “r_t4_http_server_rx_config.h” 
SYS_TIME *get_sys_time( void ); 

Parameters 
None 

Return Value 
Pointer to system time 

Remark 
Please specify the variable for system timer. 
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6.9 Sample CGI Function 
6.9.1 cgi_sample_function 

Description 
CGI function that is defined as CGI_FILE_NAME_TABLE_LIST in "r_t4_http_server_config.h" 
The second element (cgi function pointer) of CGI_FILE_NAME_TABLE_LIST will be called when web browser 
requests the defined cgi file URL. And next, HTTPd will call cgi function. 
 
HTTPd behavior will be changed by the return value. 
case: Normal termination 

CGI process finishes in this function. 
case: Internal error 

CGI process errors occur in this function. 
case: CGI pending 

CGI process does not finish in this function. The third element (cgi function pointer) of 
CGI_FILE_NAME_TABLE_LIST will be called when user will call R_httpd_pending_release_request() in 
finishing CGI process. 

Usage 
#include "r_t4_itcpip.h" 
#include "r_http_server_config.h" 
#include "r_t4_http_server_rx_if.h" 
ER cgi_sample_function(ID cepid, void *res_info); 

Parameters 
cepid Input Communication endpoint ID for which there was a CGI function execution request 
res_info Input (HTTPD_RESOURCE_INFO*)res_info->param 
   Parameter associated with the URL for which there was a request from a web browser 
  Output (HTTPD_RESOURCE_INFO*)res_info->res.body 
   HTML character string to be returned as the response 
  Output (HTTPD_RESOURCE_INFO*)res_info->res.body_size 
   Length of the HTML character string to be returned as the response 

Return Value 
-1  Internal Error 
-2  CGI pending 
0  Normal completion 

Remark 
None 
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7. Main Program Specifications 

7.1 Files 
The following table lists the files in the main program. 

 
Table 7.1.1   Main Program Files 

Folder Name File Name Description 
src main.c Main source file 

led.c LED initialization processing source file 
led.h LED initialization processing header file 
r_file_driver.c Web server file system interface source file 
r_file_driver.h Web server file system interface header file 
r_http_server_cgi_sample.c CGI sample source file 
r_sys_time.c Web server system timer source file 
r_sys_time.h Web server system timer header file 
r_usb_hmsc_api.c USB driver call processing source file 
r_usb_hmsc_api.h USB driver call processing header file 
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7.2 Modules 
The following table lists the modules in the main program. 

 
Table 7.2.1   Main Program Modules 

File Name Module Name Description 
main.c main Main processing for the main program 

Calls initialization processing for each of the 
FIT modules and drives the main processing 
for the web server, USB driver, and Ethernet 
driver (uses an infinite loop to implement 
periodic activation). 

r_usb_hmsc_api.c usb_cstd_IdleTaskStart Starts the idle task used in low-power mode. 
usb_cstd_IdleTask Idle task used in low-power mode. 

Performs no processing in host operation. 
usb_hmsc_task_start HMSC driver activation processing. 

Performs USB IP initialization and class 
driver registration. 

usb_apl_task_switch Performs task scheduling for the USB 
drivers in non-OS environments. 

usb_hapl_task_start Starts the HMSC driver application task. 
usb_hmsc_DummyFunction HMSC driver dummy function 
usb_hmsc_DriveOpen HMSC driver open processing 
usb_hapl_registration Registers HMSC drivers. 
usb_hmsc_apl_init Initializes HMSC driver application task 

internal variables. 
usb_hmsc_StrgCommandResult  R_usb_hmsc_StrgDriveSearch() callback 

processing 
usb_hmsc_SampleAplTask HMSC driver application task processing. 

Detects USB memory and mounts the file 
system. 

led.c led_init Initialization of LEDs 
r_file_driver.c - Please refer to the section 6.7 User-Defined 

Function Reference (File I/O). 
r_http_server_cgi_sa
mple.c 

- Please refer to the section 6.9 Sample CGI 
Function. 

r_sys_time.c - Please refer to the section 6.8 User-Defined 
Function Reference (System Timer). 
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7.3 Flowcharts 
This section shows the flowcharts for the modules in the main program. 

1.  main() 
This is the main() function and is first called from the startup routine for the board support package (BSP module). 
It initializes the drivers and T4 and then periodically calls Ethernet driver link up processing, web server main 
processing, and USB driver scheduling from an infinite loop. 

main

usb_cstd_ScheInit

usb_cpu_target_init

R_USB_Open

HardwareSetup

lan_open

tcpudp_get_ramsize

tcpudp_open

R_ETHER_LinkProcess

R_httpd

usb_cstd_IdleTaskStart

usb_hmsc_task_start

usb_apl_task_switch

Sample code 
processing

FIT module API// USB-BASIC-F/W scheduler initialization

// USB-BASIC-F/W hardware initialization

// USB-BASIC-F/W open

// USB sample application idle task startup

// USB sample application main task startup

// Ethernet driver hardware setup

// LAN driver open

// T4 working area size acquisition

// T4 open

// Ethernet link up processing (Ethernet ch0 and ch1 are separate)

// Web server processing

// USB sample application scheduling
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2.  usb_cstd_IdleTaskStart 
Starts the USB driver processing idle task. 

usb_cstd_IdleTaskStart

R_usb_cstd_SetTaskPri

R_SND_MSG

// Sets the priority of the USB sample application idle task

return

// Sends a startup message to the USB sample application idle task

 

 

3.  usb_cstd_IdleTask 
This is the USB driver processing idle task. 

usb_cstd_IdleTask

return
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4.  usb_hmsc_task_start 
Starts the various tasks within the USB driver, registers class drivers, and starts the USB memory mount processing 
task. 

usb_hmsc_task_start

Set host IP number

R_usb_cstd_GetUsbIpAdr

R_usb_hstd_MgrOpen

R_usb_hstd_HcdOpen

R_usb_hmsc_hub_registration

R_usb_hmsc_driver_start

R_usb_cstd_UsbIpInit

usb_hapl_registration

usb_hapl_task_start

// Acquires the base register address for the used IP

Set used IP and base register 
address for the TFAT driver

return

No

Yes

Host used?

// Starts the USB-BASIC-F/W host manager task

// Starts the USB-BASIC-F/W host control driver task

// Registers the HMSC driver

// Registers the host hub class driver

// Starts the HMSC driver task

// Starts the USB sample code main task

// USB IP initialization
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5.  usb_apl_task_switch 
Performs the USB driver scheduling. 

usb_apl_task_switch

R_usb_cstd_Scheduler

R_usb_hstd_HcdTask

R_usb_hmsc_StrgDriveTask

usb_hmsc_SampleAplTask

// USB-BASIC-F/W scheduling

return

No

R_usb_cstd_CheckSchedule

Yes

R_usb_hstd_MgrTask

R_usb_hhub_Task

R_usb_hmsc_Task

usb_cstd_IdleTask

// USB-BASIC-F/W scheduling plug acquisition

// USB-BASIC-F/W host control driver task processing

// USB-BASIC-F/W host manager task processing

// USB-BASIC-F/W hub task processing

// HMSC main task processing

// HMSC storage driver task processing

// USB sample code main task processing

// USB sample code idle task processing

USB_FLGSET?
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6.  usb_hapl_task_start 
Initializes the USB memory mount processing task. 

usb_hapl_task_start

R_usb_cstd_SetTaskPri // Sets the priority of the USB sample application main task

return

usb_hmsc_apl_init // USB sample application: scheduler variable initialization

 

 

7.  usb_hapl_registration 
Performs the class driver registration processing. 

usb_hapl_registration

R_usb_hstd_DriverRegistration // Host class driver registration

return

Class driver information preparation

 

 

8.  usb_hmsc_apl_init 
Initializes the sequence processing variables for the USB memory mount processing task. 

usb_hmsc_apl_init

return

Sequence processing variable 
initialization
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9.  usb_hmsc_DummyFunction 
Dummy function for suspend and resume specified at class driver registration. 

usb_hmsc_DummyFunction

return
 

 

10. usb_hmsc_DriveOpen 
This is the callback function called from the USB driver when USB memory is inserted. It sends a 
USB_HMSC_DRIVE_OPEN message for the sample application task. 

usb_hmsc_DriveOpen

R_USB_PGET_BLK

R_USB_SND_MSG

// Acquires a message block.

Acquisition OK?

return

No

Yes
return

Normal completion?

NoYes

R_USB_REL_BLK

// Sends USB_HMSC_DRIVE_OPEN to the sample application task.

// Releases the memory block.
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11. usb_hmsc_SampleAplTask 
This function performs the sample application task processing. It receives the USB_HMSC_DRIVE_OPEN 
message issued from the usb_hmsc_DriveOpen function and detects a mountable drive. 
Also, it receives the USB_HMSC_DRIVEMOUNT message issued from the usb_hmsc_StrgCommandResult 
function and performs a mount for the file system. 

usb_hmsc_SampleAplTask

R_USB_TRCV_MSG // Message reception

Receive OK?

return

No

Yes
return

USB_HMSC_DRIVEMOUNT

R_tfat_f_mount

Processing status = 
USB_KEY_WAIT

1

1

Processing status
USB_KEY_WAIT

// TFAT drive mount

USB_HMSC_DRIVE_OPEN

Processing status = 
USB_HMSC_DRIVE_OPEN

R_usb_hmsc_StrgDriveSearch

// Drive search request  
   message transmission

R_USB_REL_BLK

1

// Releases the memory block.
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12. led_init 
This function performs the initialization process for using the LED on the Renesas Starter Kit + for RX64M. 
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8. User-Defined Functions 
The user defined functions must be coded by the user to match the user system environment. Some of the user-defined 
functions are required by the FIT modules. 

This package includes the following user-defined function samples. See the corresponding FIT module manual or other 
documentation for specifications of these user-defined functions. 

 
Table 8.1   User-Defined Functions 

User-Defined Function File Name FIT Module Name Document Name/Catalog Number 
File system interface r_file_driver.c r_t4_http_server_rx 6.7, User-Defined Function Reference 

(File I/O) 
System timer interface r_sys_time.c r_t4_http_server_rx 6.8, User-Defined Function Reference 

(System Timer) 
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9. When CubeSuite+ is Used 
This application note can be evaluated using CubeSuite+. Note that RX Family C/C++ Compiler Package V2.02.00 or 
later is required to build this application note under CubeSuite+. This section assumes the user does not own the 
commercial version and will be using the free evaluation version. 

 

9.1 Acquire and Install CubeSuite+ 
Download CubeSuite+ from the Renesas web site. 

 
1.  Access the following URL to display the CubeSuite+ download page. 

http://www.renesas.com/cubesuite+_download 
 
2.  Of the displayed items, click [Evaluation Software] CubeSuite+ V2.02.00. (Although there are two versions, one 

that is broken up into smaller sections, and one that can be downloaded in a single operation, the contents are the 
same.) 
Next, download the CubeSuite+ installer by following the instructions displayed. 

 
 
3.  Run the downloaded CubeSuite+ installer to CubeSuite+ on your personal computer. 

See the CubeSuite+ V2.02.00 Integrated Development Environment User’s Manual: Start for details on the 
installation procedure. 
http://documentation.renesas.com/doc/products/tool/doc/r20ut2865ej0100_qsst.pdf 

 

Click this link. 

http://documentation.renesas.com/doc/products/tool/doc/r20ut2865ej0100_qsst.pdf
http://documentation.renesas.com/doc/products/tool/doc/r20ut2865ej0100_qsst.pdf
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9.2 Install the Project 
Install the Renesas common project files provided with this application note in CubeSuite+. 

 
1.  Decompress the ZIP file in which this application note is provided into an arbitrary folder. 
 
2.  Start CubeSuite+ and from the start screen, click GO under Open Existing e2 studio/CubeSuite/High-

performance Embedded Workshop/PM+ project. 

 
 
3.  Open the folder decompressed in step 1 above and of those entries, open Web server system project 

(h_httpd_system_rx64m folder). From there, select Renesas common project files 
(h_httpd_system_rx64m.rcpc) and click Open. 

 
 

Click GO. 

Select this item. 

Click Open. 
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4.  After selecting the project from the project tree, select the items as shown below and click OK. Note that 
Microcontroller used must be selected to match the device actually mounted in the evaluation board used. 

 
 
5.  The project will be converted and the converted project opened. Also, the e2 studio project will be backed up. 
 
 

9.3 Add the FIT Modules to the Project 
Add the FIT modules included in this application note and the RX64M Group Driver Package to the project. 

The added FIT modules are listed in the table below. 

 
Table 9.3.1   Added FIT Modules 

Type Module  FIT Module Name Version 
Board Support Package Board support package (BSP module) r_bsp 2.60 
Device Driver Compare match timer (CMT) r_cmt_rx 2.30 
Device Driver Ethernet controller (ETHERC) r_ether_rx 1.00 
Middleware M3S-T4-Tiny interface conversion module r_t4_driver_rx64m 1.00 
Middleware TCP/IP protocol stack (M3S-T4-Tiny) r_t4_rx 2.00 
Middleware FAT file system (M3S-TFAT-Tiny) r_tfat_rx 3.00 
Device Driver USB basic firmware r_usb_basic 1.00 
Device Driver USB host mass storage class r_usb_hmsc 1.00 
Application HTTP server r_t4_http_server_rx 1.03 
Application Web server system main program r_httpd_main_rx64m 1.00 
 
See the “RX Family: Adding Firmware Integration Technology Modules to CubeSuite+ Projects” document for the 
methods for adding FIT modules to a project. 

http://documentation.renesas.com/doc/products/mpumcu/apn/rx/r01an1826ej0100_rx.pdf 

 

Select this item. 
 

Click OK. 

http://documentation.renesas.com/doc/products/mpumcu/apn/rx/r01an1826jj0100_rx.pdf
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10. Supplement 

10.1 USB Driver Limitations 
When both USB channels ch0 and ch1 are set to host mode, only ch0 can recognize USB memory. To use ch1 in host 
mode, set ch0 to either unused or peripheral mode. 

r_config/r_usb_config.h 

/* Select USB mode(Host or Periphera) per each USB IP */ 
//  #define USB_FUNCSEL_USBIP0_PP  USB_HOST_PP  /* Host Mode */ 
//  #define USB_FUNCSEL_USBIP0_PP  USB_PERI_PP  /* Peripheral Mode */ 
    #define USB_FUNCSEL_USBIP0_PP  USB_NOUSE_PP 
 
    #define USB_FUNCSEL_USBIP1_PP  USB_HOST_PP  /* Host Mode */ 
//  #define USB_FUNCSEL_USBIP1_PP  USB_PERI_PP  /* Peripheral Mode */ 
//  #define USB_FUNCSEL_USBIP1_PP  USB_NOUSE_PP 

Figure 10.1.1   When Using ch1 in Host Mode 

 

10.2 Web Server System Limitations 
After program operation, if the USB memory is removed it will not be recognized if it is reinserted. The program should 
be restarted. 

 

10.3 Notes on Using the Free Evaluation Version of the RX Family C/C++ Compiler 
Package 

There is a usage period limitation and certain usage limitations on the free evaluation version of the RX Family C/C++ 
Compiler Package. If the usage period is exceeded, load modules may not be generated correctly due to the usage 
limitations. 

See the page on evaluation software on the Renesas web site at the link below. 

http://www.renesas.com/products/tools/evaluation_software/index.jsp 

 
 

http://www.renesas.com/products/tools/evaluation_software/index.jsp
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Website and Support 
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All trademarks and registered trademarks are the property of their respective owners. 
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General Precautions in the Handling of MPU/MCU Products 
 
The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that 
have been issued for the products. 
 

1.  Handling of Unused Pins 
Handle unused pins in accordance with the directions given under Handling of Unused Pins in the 
manual. 
 The input pins of CMOS products are generally in the high-impedance state. In operation with an 

unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an 
associated shoot-through current flows internally, and malfunctions occur due to the false 
recognition of the pin state as an input signal become possible. Unused pins should be handled as 
described under Handling of Unused Pins in the manual. 

2.  Processing at Power-on 
The state of the product is undefined at the moment when power is supplied. 
 The states of internal circuits in the LSI are indeterminate and the states of register settings and 

pins are undefined at the moment when power is supplied. 
In a finished product where the reset signal is applied to the external reset pin, the states of pins 
are not guaranteed from the moment when power is supplied until the reset process is completed. 
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function 
are not guaranteed from the moment when power is supplied until the power reaches the level at 
which resetting has been specified. 

3.  Prohibition of Access to Reserved Addresses 
Access to reserved addresses is prohibited. 
 The reserved addresses are provided for the possible future expansion of functions. Do not access 

these addresses; the correct operation of LSI is not guaranteed if they are accessed. 
4.  Clock Signals 

After applying a reset, only release the reset line after the operating clock signal has become stable. 
When switching the clock signal during program execution, wait until the target clock signal has 
stabilized. 
 When the clock signal is generated with an external resonator (or from an external oscillator) 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. 
Moreover, when switching to a clock signal produced with an external resonator (or by an external 
oscillator) while program execution is in progress, wait until the target clock signal is stable. 

5.  Differences between Products 
Before changing from one product to another, i.e. to a product with a different part number, confirm 
that the change will not lead to problems. 
 The characteristics of an MPU or MCU in the same group but having a different part number may 

differ in terms of the internal memory capacity, layout pattern, and other factors, which can affect 
the ranges of electrical characteristics, such as characteristic values, operating margins, immunity 
to noise, and amount of radiated noise. When changing to a product with a different part number, 
implement a system-evaluation test for the given product. 
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